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Quick Tour of AutoCAD 2008

Welcome to Using AutoCAD 2008: Basics!

As a new user, you need to experience the feel of AutoCAD firsthand. The concepts behind computer-
aided design software can be disorienting to first-time user, and so this quick-start chapter gets your
feet wet. It introduces you to features discussed in detail in later chapters.

This chapter is specifically designed to acquaint you with AutoCAD. Subsequent chapters cover the
subject more thoroughly. In this chapter, you learn these commands:

NEW starts fresh drawings.

LINE draws straight line segments.

U undoes mistakes.

QUIT exits AutoCAD.

CLOSE and CLOSEALL close drawings.

SAVEAS renames drawings, and then saves them.

PLOT prints the drawing on paper.

Let’s get started!
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STARTING AUTOCAD

Before you can install and run AutoCAD for the first time, your computer must have Microsoft®
Windows™ 2000, XP, TabletPC, Server 2003, or Vista installed and running.

TUTORIAL: STARTING AUTOCAD

1. To start AutoCAD 2008, use one of these methods:
• On the Windows desktop, double-click the icon labeled AutoCAD 2008.

(Double-click means to press the left mouse button twice, quickly.)

• Alternatively, you can also start AutoCAD from the Windows taskbar. Click the Start button,
and then choose Programs. Next, choose Autodesk | AutoCAD 2008 | AutoCAD 2008.
(Your copy of Windows may show a display that differs from the one illustrated below.)

• In the Windows Explorer (a.k.a File Manager), double-click a .dwg drawing file. (If AutoCAD add-
ons, such as Mechanical Desktop or Architectural Desktop, are installed, they may start instead.)

• In the Run dialog box, enter acad.exe.

Run: acad.exe (Press ENTER.)
(The above procedure bypasses command-line startup switches associated with the icon.)

2. In all cases, Windows opens the AutoCAD software.
An opening screen is displayed, called the “splash screen.”
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After the splash screen disappears,  you see AutoCAD.
3. AutoCAD sometimes shows several dialog boxes before it finishes starting up. Here is what

to do with them:
• If the New Features Workshop appears, choose Maybe Later, and then click OK.

• If the Startup dialog box appears, choose the Start from Scratch button, and then
     select Imperial (feet and inches). Click OK.

4. The AutoCAD window looks similar to the figure below, except that the background color
of the drawing area may be black, instead of white. (The Sheet Set Manager palette, Tool
palette, and Express Tools toolbars may appear; you can close them or ignore them.)
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DRAWING IN AUTOCAD

You make drawings in AutoCAD by creating and editing objects. You instruct AutoCAD through
commands, which are often simple words such as LINE, CIRCLE, MOVE, and ERASE. Commands describe
the objects to be drawn — LINE or CIRCLE — and the operation to perform — MOVE or ERASE.

Commands can be executed by several different methods: typing them on the keyboard, selecting them
from menus and toolbars, double-clicking or right-clicking the mouse, and by using shortcut keystrokes.
Use whichever method you prefer.

Command Prompt Area
At the bottom of the AutoCAD window is the command prompt area. This is where you enter typed
commands, and one of the places where AutoCAD responds to you. You should see the word “Command:”
on that line now.

Command:
(If you do not see the command prompt area, press CTRL+9 to make it appear. AutoCAD has a larger
version of the command prompt area called the “Text window,” which displays only the text from
commands. You can see it by pressing function key F2; press F2 again to bring back the graphics window.)

Dynamic Input

The drawing area is a second place where you can type commands and receive feedback from AutoCAD.
When dynamic input is turned on, the command prompts and options appear near the cursor.

Command Prompt Area

Drawing Area

Crosshair
Cursor

Menu Bar

Toolbars

Layout Tabs

UCS
Icon

Status Bar

Dashboard

InfoCenter
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(To turn on dynamic input, click the DYN button on the status bar, and ensure the cursor is in the
drawing area.) You learn more about dynamic input in Chapter 2, “Understanding CAD Concepts.”

Mouse
As an alternative to typing commands, you can use a mouse, digitizing tablet, or other input device to
control AutoCAD. (From this point forward, we refer to the mouse only, being the most common input
device.) To see how the mouse interacts with AutoCAD, follow these steps:

1. Move the mouse, and notice how the crosshair cursor moves around the screen.
When the cursor looks like a crosshair, it specifies points in drawings.

2. Move the crosshair cursor out of the drawing area. Notice that the cursor changes to an
arrow.  This lets you select commands from menus and toolbars.

USING MENUS

A common method for selecting commands is through the menus — just as in almost all other Windows
software. The menus contain many of AutoCAD’s commands, which can be selected with the mouse.
To see how they work, select a command from the menu — choose the Line item from the Draw
menu, as follows:

TUTORIAL: SELECTING MENU ITEMS

1. To select a command from the menu, move the crosshair cursor to the menu bar.  As the
cursor moves out of the drawing area, it changes from the crosshair to the slanted arrow.

2. As you move the arrow across the words on the menu bar, each is highlighted: File, Edit,
View, and so on.
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3. Select the Draw menu: when Draw is highlighted by the cursor, click the left mouse
button. Notice that a menu drops down into the drawing area.

4. Move the pointer down the menu past Modeling, Line, Ray, and so on.  As you do, notice
that each word is highlighted.

5. Move back up, and then pause the cursor on Line. Notice the line of words that appears
on the status line — “Creates straight line segments: LINE.” This tells you the purpose of
the menu item.

6. With the cursor on Line, click the left mouse button.
Notice that text appears in the command bar at the bottom of the window:

Command: _line Specify first point: (Pick a point.)

This is called a prompt. In the command bar,  AutoCAD tells you what it expects from you.
Here,  AutoCAD is asking you to specify the point from which the line starts, called the
“first point.”

7. Move the crosshair cursor into the drawing area, and then enter a point (click the left
mouse button).

8. Continue to move the crosshair cursor around the screen. Notice how a line “sticks” to
the intersection of the cursor crosshairs. This is called “rubber banding”: the line stretches
and follows your movement.
If dynamic input is turned on, then the prompt appears next to the cursor, as illustrated
below.

9. The prompt has changed slightly with the addition of “or [Undo]”:
Specify next point or [Undo]: (Pick another point.)

Move the cursor, and pick a point approximately at the point shown in figure below.
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The word Undo is an option.  AutoCAD shows options in square brackets, such as [Undo].
Options are alternative actions that can be performed by the command.  (Undo
“undraws” the previous line segment, which is useful when you make mistakes.)

10. The LINE command remains active, allowing you to draw as many line segments as you
need without reselecting the command. Continue to enter lines as shown in the figure
below.  As you do, the prompt changes to:

 Specify next point or [Close/Undo]:

Close is another option of the LINE command.  When you enter Close, it draws a line
segment from the end of the last segment to the start of the first segment.

11. To end the command, click the right mouse button. From the shortcut menu, choose
Enter, as illustrated by the figure below. (Alternately, press ESC on the keyboard; for some
commands, you need to press ESC twice before they end.)

12. Enter the U command (short for “undo”) to erase the lines you drew.
Command: u (Press ENTER.)

AutoCAD confirms:
Everything has been undone.

WORKSPACES

The way that AutoCAD looks — its menus, toolbars, Dashboard panels, and palettes — is controlled
by workspaces. Selecting a different workspace changes the number and position of these user interface
items. You can select from three workspaces predesigned by Autodesk from the Workspaces toolbar, as
illusrated below.

Workspaces are described in greater detail in Chapter 3, “Setting Up Drawings.” For now, it is sufficient
to know that if you do not see a toolbar or menu item, your workspace may have changed.

This book works with AutoCAD’s default workspace, “2D Drafting & Annotation.” To return AutoCAD
to its default look, select this name from the Workspace toolbar.

TOOLBARS

Toolbars consist of buttons; each button is labeled by a small picture called an “icon.” Icons represent
commands carried out by buttons.  Similar commands are grouped together; for example, most drawing
commands appear on the Draw toolbar. AutoCAD has nearly three dozen toolbars, most of which are
not initially displayed
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AutoCAD 2008 reduces the number of toolbars displayed, depending on the workspace selected. The
default workspace, “2D Drafting & Annotation,” shows just two toolbars, as illustrated below.

The two toolbars are:

• Workspaces selects the workspace to be displayed.

• Standard-Annotation contains some of the same commands found in other Windows
applications, plus a number specific to AutoCAD.

The “3D Modeling” workspace also displays the Layers toolbar, while the “AutoCAD Classic” workspace
displays all the toolbars you might expect, if you are used to AutoCAD 2006 and earlier.

The added toolbars include:

• Draw toolbar draws many different objects, such as lines, arcs, and hatch patterns.

• Layers toolbar controls layers in the drawing.

• Properties toolbar changes the properties of objects.

• Styles toolbar accesses text, dimension, and table styles.

• Modify toolbar edits objects to change their size, location, and other properties.

Using Toolbar Buttons
Every button on every toolbar activates a command or series of commands. For example, the first
button of the Draw toolbar is Line. It starts the LINE command. The icon for LINE is the diagonal line
with a dot at either end.

When you cannot remember the purpose of a button, move the cursor over the button and wait a
second or two. AutoCAD then displays a tooltip, a one- or two-word description of the button’s purpose,
as well as shortcut keystrokes, if available. Tooltips also appear in the Dashboard, but not in the menus.

The status bar (at the bottom of the AutoCAD window) displays a one-sentence description of the
command’s purpose. In the case of the Open button, the status bar reads, “Opens an existing drawing
file: OPEN.”

Standard-Annotation toolbarWorkspaces toolbar

Draw
toolbar

Styles toolbar

Modify
toolbar

Properties toolbarLayers toolbar
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The same help text appears on the status bar when you access commands from the menus, but not
from the Dashboard panels.

DASHBOARD PANELS

Dashboard panels are like toolbars, but tend to be fixed to the right end of the AutoCAD window.
Like toolbars, panels group similar commands together.

The 2D Drafting & Annotation workspace displays the following panels, from top to bottom:

• Layers controls layers and layer states; see Chapter 7.

• 2D Draw draws many objects, such as lines and circles; see Chapter 3.

• Annotation Scaling ensures scale-dependent objects plot at the correct size.

• Dimensions places dimensions in drawings; see Chapter 13.

• Text places text, checks spelling, selects styles, and so on; see Chapter 12.

• Multileaders places and edits multiline leaders; see Chapter 15.

• Tables inserts and edits tables, and creates links to external data files; see Chapter 16.

• 2D Navigate zooms and pans the drawing; see Chapter 5.
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TUTORIAL: DRAWING WITH BUTTONS

To draw a line with a button on the Dashboard or a toolbar:
1. Position the cursor over the Line button in the 2D Drafting Dashboard panel.

2. Click the left mouse button.
At the command line, you see the familiar prompt:

Command: _line Specify first point:
3. Draw some lines, and then press ESC to exit the command.

Flyouts
Sometimes buttons represent secondary toolbars. You recognize these buttons on toolbars and
Dashboard panels by the tiny black triangle in the corner of their icons. The triangle indicates the
presence of a flyout, a group of buttons that “flies out” from the button.

TUTORIAL: ACCESSING FLYOUTS

1. To access flyouts:
Position the cursor over any tiny triangle next to a button, such as the Circle button
illustrated below.

2. Hold down the left mouse button.  Notice that AutoCAD displays a flyout toolbar.

3. Without letting go of the mouse button, drag the cursor over the buttons on the flyout.
As the cursor passes over a button, it changes slightly to give the illusion of being
depressed.

4. When you reach the button you want, release the mouse button.  AutoCAD starts the
command associated with the button.
In some cases, the button you selected moves to the top of the toolbar where it is the
default next time.

Manipulating Toolbars
Toolbars have many controls hidden in them. You can move, resize, float, dock, and dismiss toolbars.
Here’s how:
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To move a docked toolbar, position the cursor over the two “bars” at the left end of
horizontal toolbars (or the top end of vertical toolbars).

Hold down the mouse button, and drag the toolbar away from the edge of the window.

Release the mouse button. The toolbar now floats in the drawing window, and sports a title bar
(as shown below).

To move a floating toolbar, position the cursor over the title bar. Hold down the mouse
button and drag the toolbar to another location.

To resize (or stretch) a toolbar, position the cursor over one of its four edges. Hold
down the left mouse button, and then drag the toolbox to achieve a new shape.

To dock a toolbar, drag it against one of the four sides of the drawing area. Docking means to
move it to the side or top of the drawing area, like the docked toolbars below the menu bar,
illustrated in the figure below.

To dismiss (get rid of) a floating toolbar, click the tiny x in the upper right corner.  The
toolbar disappears.

To get back the toolbar, right-click any toolbar button. From the shortcut menu, select its
name from the list.

Leave at least one toolbar visible so that you can easily access the other toolbars. If you do close
them all, you can use the View | Toolbars command to reopen them.
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EXITING DRAWINGS

AutoCAD provides several different ways to close drawings and exit AutoCAD. The following sections
outline the possibilities. Choose the option you want, and follow the instructions.

DISCARD THE DRAWING, AND EXIT AUTOCAD

When you don’t want to keep your drawing, and wish to stop working:

1. Enter the QUIT or EXIT commands (from the keyboard), or choose Exit from the File
menu. Notice that AutoCAD displays a dialog box to confirm whether you want to save
the drawing — it’s your last chance!

2.  Move the cursor to choose the No button to exit without saving your work.  AutoCAD
does not record your work to disk, and exits to the Windows desktop.

Save the Drawing, and Exit AutoCAD
To save your work and exit AutoCAD:

1. Enter the same QUIT command in the command window (or select Exit from the File
menu).

2. This time choose Yes to save your work. Notice that AutoCAD displays the Save Drawing
As dialog box.

3. Name the drawing in the File name text box, and then choose Save.  AutoCAD saves
your work under the name, and exits to the Windows desktop.

Save the Drawing, and Remain in AutoCAD
If you want to keep your work and remain in AutoCAD:

1. Enter the QSAVE command (or select File | Save from the menu).
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2. If the drawing has not yet been named, the same Save Drawing As dialog box appears;
name the file, and then choose Save.

Remain in AutoCAD, and Start a New Drawing
If you would like to start a new AutoCAD drawing:

1. Use the NEW command.
2. AutoCAD displays the Select Template dialog box, which looks like the dialog box shown

above. Select a template file, and then click Open.

Close the Drawing and Remain in AutoCAD
You can have more than one drawing open in AutoCAD. To close one or more drawings, follow one of
these options:

• To close the current drawing, enter the CLOSE command (or from the File menu, select Close).
If necessary,  AutoCAD asks if you wish to save the drawing.  AutoCAD then closes the drawing.

• To close all drawings at once, enter the CLOSEALL command; from the Window menu, select
Close All.

With the basics of navigating AutoCAD behind you, practice drawing in AutoCAD. In the following
tutorial, you draw a two-dimensional object.

2D TUTORIAL

The figure below illustrates the drawing you construct in this tutorial. It is the plan view of a base
with four holes, and a shaft with rounded edges.

The following tutorial describes the commands to complete the drawing. The commands you type appear
on the command line. Your responses are shown by boldface in this tutorial. (You can type the items
in either uppercase or lowercase.)
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Items enclosed in parentheses (such as these) are instructions and are not typed. If ENTER is shown,
press the ENTER key on the keyboard. For example:

Command: line (Press ENTER.)
Type the LINE command, and then press ENTER.

If you make a mistake, just type U, and then press ENTER. (Or, you can click the Undo button on the
toolbar, or press CTRL+Z.) This undoes the previous step. You may use it several times to undo each
step in reverse order.

Before entering a command, the prompt on the command line must be “empty,” with nothing following
the colon:

Command:
If not, press ESC. This cancels the current command, and makes AutoCAD ready for your command.

 SETTING UP NEW DRAWINGS

1. To make sure  AutoCAD displays the Create New Drawing dialog box, enter the following
command:

Command: startup
Enter new value for STARTUP <0>: 1 (Press ENTER.)

2. Start a new drawing. From the File menu, choose New.
3. In the Create New Drawing dialog box, choose the Use a Wizard button.

4. Select Quick Setup, and then choose the OK button.
Notice that AutoCAD displays the Quick Setup dialog box.

Quick Setup presents a short series of setup dialog boxes that lead you through the steps
of quickly setting up a new drawing with units and limits.
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5. In the first dialog box, you specify the units. Accept the default of Decimal by choosing
the Next button. Notice that AutoCAD displays the Area dialog box.

6. Here you specify the limits of the drawing: 12 units wide by 10 units tall (long).In the Area
dialog box, define the area by clicking the Length text box.
Clear the current value using the DEL or BACKSPACE key.

7. Type 10, and then press the TAB key to see the effect in the preview image.
Keep the Width at 12.

8. Choose Finish.  AutoCAD dismisses the dialog box.

SETTING UP DRAWING AIDS

To draw accurately, you need to turn on drawing aids like grid and snap.

The grid is a visual guide that shows distances. Think of it as graph paper with dots, instead of lines.
When the grid is set to 1 unit, for example, the drawing is covered with dots spaced one unit apart.
The grid is only displayed on the screen; it is not printed.

Snap is like drawing resolution. When on, snap causes the cursor to move in precise increments. When
the snap is set to 1 unit, for example, the cursor moves in one-unit increments. The grid and snap can
have either the same or different spacing).

1. From the Tools menu, choose Drafting Settings. Notice that AutoCAD displays the
Drafting Settings dialog box.

2. Select the Snap and Grid tab.
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3. Turn on snap by clicking the check box next to Snap On.
 Check mark indicates the option is turned on.
 No check mark means option is turned off.

The F9 next to Snap On reminds you to press function key F9 to turn snap on and off.
This is handy when you need to toggle (turn on and off) snap during commands.
(Alternatively, click the word SNAP on the status bar at the bottom of the AutoCAD
window.)

4. Change both the Snap X spacing and Snap Y spacing to 1.
5. Do the same for the grid: turn it on, and set the grid spacing to 1.

The settings in the dialog box should look like the highlighted area in the figure below.

6. Choose OK to dismiss the dialog box. Notice that a grid of fine dots fills the drawing area.
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If the dots don’t fill the drawing area, use the ZOOM command with the All option to see
all of the drawing:

Command: zoom
Specify corner of window, enter a scale factor (nX or nXP), or
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real time>: all

7. Move the mouse to see the crosshairs cursor move in increments of one unit.

DRAWING THE BASEPLATE

The baseplate is a square. You can draw it with the RECTANGLE command, which is AutoCAD’s easiest
command for drawing rectangles and squares.

AutoCAD needs to know two things to draw a square: the position of two opposite corners.

1. From the Draw menu bar, select Rectangle.
As an alternative, enter the RECTANGLE command at the keyboard:

Command: rectangle (Press ENTER.)
2. AutoCAD next needs to know where to place the square. One corner is at the x,y

coordinates of 3,2:
Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: 3,2 (Press ENTER.)

3. The opposite corner is located at x,y coordinates of 9,8:
Specify other corner point or [Dimensions]: 9,8 (Press ENTER.)

Specify First Corner Point
(3,2)

Specify Other Corner Point
(9,8)

Unlike the LINE command, the RECTANGLE command stops by itself; there is no need to
press ESC.

4. Your drawing should look similar to the figure above. If necessary, enter the ZOOM

command, and select the All option:
Command: zoom (Press ENTER.)
Specify corner of window ... <real time>: all (Press ENTER.)

DRAWING THE SHAFT

The shaft is also a square, but with rounded corners. The RECTANGLE command can draw squares with
corners that are square (as above), rounded (also known as “filleted”), or cutoff (“chamfered”).

Draw the square shaft by repeating the RECTANGLE command. In addition to specifying the two corners,
you tell AutoCAD the radius of the rounded corners.
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1. In AutoCAD, pressing the SPACEBAR repeats the previous command — this is a handy
shortcut that saves you typing the full name a second time.

Command: (Press SPACEBAR.)
RECTANGLE

2. Rounded corners are called “fillets,” and their size is specified by radius. To specify the
radius of the fillets, enter the Fillet option:

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: fillet (Press ENTER.)
3. The fillets are 0.5 inches in radius:

Specify fillet radius for rectangles <0.0000>: .5 (Press ENTER.)
4. With the fillet radius set, specify the corners of the square using x,y coordinates:

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: 5,4 (Press ENTER.)
Specify other corner point or [Dimensions]: 7,6 (Press ENTER.)

Your drawing should look similar to the figure.

Specify Other Corner Point
(7,6)

Specify First Corner Point
(5,4)

DRAWING HOLES

Now draw the “holes” in the baseplate. Holes can be drawn with circles.

To draw a circle, AutoCAD needs to know two things: (1) the position of the circle in the drawing,
based on its center point; and (2) the radius (or diameter) of the circle.

Specify Center Point
(4,3)

Specify Radius
(0.25)
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1. From the Draw menu, select Circle. Notice that AutoCAD enters the command name for
you, and immediately moves on to the first prompt:

Command: _circle
2. One circle is located at 4,3 in the drawing:

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 4,3 (Press ENTER.)
3. The circle has a radius of 0.25 units:

Specify radius of circle or [Diameter]: 0.25 (Press ENTER.)

COPYING CIRCLES

To draw the other three circles, you don’t need to repeat the CIRCLE command; instead, you can copy
the first one to the other locations on the baseplate using the COPY command.

AutoCAD needs to know two things for making copies: (1) which object(s) is to be copied; (2) the
location to place the copies. Often, the location is specified as the distance from the original to the
copies.

1. Select the object to be copied using AutoCAD’s object selection method called “Last” (or
“L” for short). It select the last-drawn object visible on the screen, as follows:

Command: copy (Press ENTER.)
Select objects: L (Press ENTER.)

Notice that the circle changes its look: it is made of dashed lines.

This effect is called “highlighting,” and is how AutoCAD indicates selected objects.
2. Press ENTER to tell AutoCAD you have finished selecting objects.

1 found Select objects: (Press ENTER to end object selection.)
3. To specify the distance that the circle should be copied, you tell AutoCAD the base point

and the displacement. The base point is the point from which the copying takes place:
Specify base point or [Displacement] <Displacement>: 4,3 (Press ENTER.)

Specify Base Point
(4,3)

Specify Second Point of Displacement
(8,3)

Specify Second Point
of Displacement

(8,7)

Specify Second Point
of Displacement

(4,7)

4. The displacement is the point at which the copy is placed:
Specify second point of displacement or <use first point as displacement>: 8,3 (Press ENTER.)
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5. The copy command repeats its displacement prompt so that you can make multiple copies:
Specify second point of displacement...: 8,7 (Press ENTER.)
Specify second point of displacement...: 4,7 (Press ENTER.)

6. Press ESC to tell AutoCAD you have finished making copies:
Specify second point of displacement...: (Press ESC to end the command.)

Your drawing should look similar to the figure illustrated above.

SAVING THE DRAWING

With the drawing complete, it is time to save your valuable work.

1. On the Standard toolbar, click the Save button (looks like a diskette, if you can recognize it!).

2. In the Save Drawing As dialog box, enter “tutorial” for the File name.
3. Click Save to save the drawing.

On the title bar, notice that the name changes from the generic [Drawing1.dwg] to
[tutorial.dwg], perhaps prefixed by the path name.

PLOTTING THE DRAWING

With the drawing saved, print out a copy to show your fine work to your instructor, family, and friends!
This is done with the PLOT command.

Before printing, AutoCAD needs to know: (1) the printer on which the drawing will be plotted, (2)
the view to plot, and (3) the size. There are many other options, but these three are the most important.

1. From the File menu, select Plot. Notice that  AutoCAD displays the Plot dialog box.
2. In the Printer/plotter area, select a printer from the Name droplist. “Default Windows

System printer.pc3” is usually a safe choice.

3. In the Plot Area section, select Extents from the What to Plot droplist.  This option
ensures the entire drawing is plotted.
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4. In the Plot Offset section, select Center the plot to center the drawing on the paper.

5. In the Plot Scale area, select Fit to Paper. This option ensure the drawing fits the paper,
no matter the size of paper.

6. To ensure the plot works out correctly, and to save paper, click the Preview button.

AutoCAD shows you what the plot will look like, as illustrated by the figure below.



24

7. Press ESC to exit the print preview mode.
Press ESC or ENTER to exit, or right-click to display shortcut menu. (Press ESC.)

8. Back in the Plot dialog box, choose OK to start the plot.
AutoCAD displays a dialog box showing the progress of the plot. When done, a yellow
alert balloon appears at the right end of the status bar, reporting on the success of the plot
(or lack thereof).

After a moment, the drawing should emerge from your printer.
9. Save the drawing with the QSAVE command, and then exit AutoCAD, as you learned earlier

in this chapter.

3D TUTORIAL

Let’s repeat the tutorial and draw the same part in three dimensions. The figure below illustrates the
baseplate with its four holes and shaft with rounded edges.

Box

Box with
Filleted Edges Hole

(cylinder removed
from box)

Modeling objects in 3D is quite different from 2D drafting, because 3D objects are made from solid
primitives, parts like boxes and cylinders. For example, the base is made of a box, the shaft is another
box with edges filleted, and the holes are cylinders removed from the base.

As well, you work in a different modeling workspace.

1. Start AutoCAD with the 3D Modeling workspace. (If AutoCAD is already running, choose
the Tool menu, Workspaces, and then 3D Modeling. Start a new drawing with the
acad3d.dwt template file.)
Notice that AutoCAD’s environment changes significantly.
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3D UCS Icon
at drawing origin

(0,0)

Grid
(made of lines)

3D Cursor
(x, y, z)

Tool Palette
(with materials)

3D Modeling
DashboardPerspective

Projection

Ensure dynamic input is turned off; otherwise your results may differ from this tutorial. Click the DYN
button on the status bar.

2. From the Draw menu bar, select Modeling, and then choose Box.
As an alternative, enter the BOX command at the keyboard:

Command: box (Press ENTER.)
3. AutoCAD next needs to know where to place the box. One corner is at the x,y

coordinates of 3,2:
Specify first corner or [Center]: 3,2 (Press ENTER.)

4. The opposite corner is located at x,y coordinates of 9,8:
Specify other corner or [Cube/Length]: 9,8 (Press ENTER.)

5. The height is 0.5:
Specify height or [2Point]: 0.5 (Press ENTER.)

Specify First Corner
(3,2)

Specify Other Corner
(9,8)

Specify Height
(0.5)

6. Your drawing should look similar to the figure above. If necessary, enter the ZOOM

command, and select the All option:
Command: zoom (Press ENTER.)
Enter option [All/Extents/Window/Previous] <real time>: all (Press ENTER.)



26

MODELING THE SHAFT

The shaft is also a box, but with rounded edges. Unlike RECTANGLE, the BOX command doesn’t have a
built-in filleting option, so you’ll need to use the FILLET command later.

1. Recall that the SPACEBAR repeats the previous command — without requiring you to type
its name a second time. Press it to repeat the BOX command.

Command: (Press SPACEBAR.)
BOX

2. To make the boxes easier to see and work with, turn on transparency. In the Dashboard,
click the X-ray Mode button (found in the Visual Styles control panel).

3. Specify the corners and height of the box by typing x,y coordinates, as follows:
Specify first corner or [Center]: 5,4 (Press ENTER.)
Specify other corner or [Cube/Length]: 7,6 (Press ENTER.)
Specify height or [2Point]: 6 (Press ENTER.)

Specify First Corner
(5,4)

Specify Other Corner
(7,6)

Specify Height
(6)

4. To round the edges of the box, enter the FILLET command:
Command: fillet
Current settings: Mode = TRIM, Radius = 0.0000

5. Enter the “m” option (short for multiple), because you will be filleting multiple (four) edges:
Select first object or [Undo/Polyline/Radius/Trim/Multiple]: m

6. The fillets are 0.5 inches in radius:
Enter fillet radius <0.0000>: 0.5 (Press ENTER.)

Notice that the cursor changes to a small square; this is called the “pick” cursor.
7. Now tell AutoCAD which edges to fillet by picking each one: you must position the square

pick cursor over each edge, and then click the left mouse button:
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Select an edge or [Chain/Radius]: (Pick an edge.)

Select an Edge

Select an Edge

Select an Edge

Select an Edge

As you do, the edge turns white. Repeat for the other three edges:
Select an edge or [Chain/Radius]: (Pick another edge.)
Select an edge or [Chain/Radius]: (Pick a third edge.)
Select an edge or [Chain/Radius]: (Pick the last edge.)

8. With the four edges selected, press ENTER to exit selection mode:
Select an edge or [Chain/Radius]: (Press ENTER to exit selection mode.)
4 edge(s) selected for fillet.

9. Press ENTER a second time to exit the command.
Select first object or [Undo/Polyline/Radius/Trim/Multiple]: (Press ENTER to exit the command.)

Filleted Edge

Notice that the column has rounded edges.
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MODELING HOLES

The next step is to draw the holes in the baseplate. In AutoCAD, holes are constructed by drawing,
then removing, cylinder shapes.

1. From the Draw menu, select Modeling, and then choose Cylinder.
Command: _cylinder

2. The cylinder is located at 4,3 in the drawing:
Specify center point of base or [3P/2P/Ttr/Elliptical]:  4,3 (Press ENTER.)

Specify Center Point
(4,3)

Specify Base Radius
(0.25)

Specify Height
(1)

3. The circle has a radius of 0.25 units:
Specify base radius or [Diameter]: .25  (Press ENTER.)

4. The height does not matter, just as long as it is taller than the base:
Specify height or [2Point/Axis endpoint] <6.0>: 1 (Press ENTER.)

COPYING CYLINDER

To draw the other three cylinders, use the COPY command to copy the first cylinder to the other
locations on the baseplate.

1. Start the COPY command, and then select the last-drawn cylinder with the L object
selection option, as follows:

Command: copy (Press ENTER.)
Select objects: L (Press ENTER.)
1 found Select objects: (Press ENTER to end object selection.)

2. Recall that the base point is the point from which the copying takes place:
Specify base point or [Displacement] <Displacement>: 4,3 (Press ENTER.)

Specify Base Point
(4,3)

Specify Second Point
of Displacement

(8,3)

Specify Second Point
of Displacement

(8,7)

Specify Second Point
of Displacement

(4,7)
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3. The displacement is the point at which each copied cylinder is placed:
Specify second point of displacement or <use first point as displacement>: 8,3 (Press ENTER.)
Specify second point of displacement...: 8,7 (Press ENTER.)
Specify second point of displacement...: 4,7 (Press ENTER.)
Specify second point of displacement...: (Press ESC to end the command.)

SUBTRACTING CYLINDERS TO CREATE HOLES

With the four cylinders in place, you now use the SUBTRACT command to turn them into holes.

1. From the Modify menu, select Solid Editing, and then choose Subtract.
AutoCAD first asks you for the object(s) to subtract from; that would be the baseplate:

Select solids and regions to subtract from ..
Select objects: (Select the baseplate.)
Select objects: (Press ENTER to end object selection.)

2. Now AutoCAD needs to know which objects to subtract; that would be the four cylinders:
Select solids and regions to subtract ..
Select objects: (Select one cylinder.)
Select objects: (Select another cylinder.)
Select objects: (Select a third cylinder.)
Select objects: (Select the fourth cylinder.)
Select objects: (Press ENTER to end object selection.)

Notice that AutoCAD removes the cylinders from the baseplate, creating four holes.

3. The final step is to join the shaft with the baseplate. This is done with the UNION command.
From the Modify menu, select Solid Editing, and then choose Union.  AutoCAD asks
you for the objects to bring together:
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Select objects: (Select the base plate.)
Select objects: (Select the shaft.)
Select objects: (Press ENTER to end object selection.)

The model does not look any different, but it is now a single object.
4. Save the drawing as “3d Tutorial,” and then print, if you wish.

So, that was a quick start to using AutoCAD.

Welcome to the rest of Using AutoCAD 2008: Basics. The remaining chapters take you step by step
through the program. Before long, you’ll be using AutoCAD to create drawings like a pro.

Enjoy!
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EXERCISES

1. In this exercise, you start drawing in AutoCAD.
Start AutoCAD. (If the Start New Drawing dialog box appears, click Cancel.)
With the LINE command, draw several shapes:
a. Rectangle.
b. Triangle.
c. Irregular polygon (any shape you like).

2. Use the U command. What happens to the last object you drew?

3. Press function key F9, and then look at the status line.
Does the button look depressed (pressed in)?

4. Repeat the LINE command, and again try drawing these shapes:
a. Rectangle.
b. Triangle.
c. Irregular polygon.
Do you find it easier?

5. Draw a rectangle with the RECTANGLE command using these parameters:
Corner 2,3
Other corner 6,7

6. Draw a circle with the CIRCLE command using these parameters:
Center point 4,5
Radius 0.75
Is the circle drawn “inside” the box?

7. Print your drawing with the PLOT command.
Does the plot look like the drawing on your computer screen?
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CHAPTER REVIEW

1. What are AutoCAD drawings constructed with?
2. Name three areas in which commands are entered:

a.
b.
c.

3. Describe the purpose of the ‘Command:’ prompt.
4. How do you exit from print preview mode?
5. What is the purpose of the LINE command?
6. How is the U command helpful?
7. Describe how to cancel commands.
8. What does the mouse control?
9. What is an icon?
10. Name two methods by which you can determine the function of toolbar buttons:

a.
b.

11. What are tooltips?
12. What are flyouts?
13. Can toolbars be moved around the AutoCAD window?
14. Which commands close drawings without exiting AutoCAD?
15. Which commands exit AutoCAD?
16. Which command saves drawings?
17. Which command starts new drawings?
18. Describe how snap and grid are useful:

Snap
Grid

19. Is the grid plotted?
20. List three things AutoCAD needs to know, as a minimum, before plotting drawings:

a.
b.
c.

21. Explain the advantage of the PLOT command’s Fit to Scale option.
22. Why is the Preview option environmentally friendly?
23. How do you exit from print preview mode?
24. Identify the user interface elements illustrated below:

a.
b.
c.
d.
e.


